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Welcome to the
Super Solvers Club!

Are you ready to accept your official Super Solvers Club
: assignment? If this is your first adventure with
the club, a little bit of background is in
order. If you completed an earlier
assignment in Midnight Rescue!,
read on to find out how your past
experience can help you in this excit-
ing new adventure.

Super Solvers Club members are dedicated to
outwitting Morty Maxwell, the prankster of
Shady Glen. Unappreciated as a student,
Morty has returned to his hometown as the
Master of Mischief to show one and all that he
is the cleverest one around.

In the first Super Solvers adventure, Midnight Rescue!, Super
Solvers are called upon to stop the Master of Mischief’s outra-
geous plan to make the Shady Glen School vanish into thin air.
Using disappearing paint and the aid of his five robot helpers,
he hopes to complete his mis-
chief by midnight. To compli-
cate matters further, he has dis-
guised himself as one of his
robot helpers. As a Super Solvers Club mem-
ber, you must figure out which robot is really
the Master of Mischief before you can spoil
his plan.




Always one for a challenge, the Master of Mischief has clev-
erly placed clues about his identity throughout the school. You
must move quickly and carefully through the rooms and hall-
ways to find them, using your best reading skills to reveal their
secrets. But the clues alone won’t help you unless you use
your official club camera to capture photo facts about each
robot. With clues and facts in hand, just apply your Super
Solvers thinking skills to uncover the Master of Mischief in
time to save the school.

In OutNumbered!, the Master of Mischief is back with a new
set of helpers and a fiendish plan to take over the Shady Glen
TV (SGTV) station. From his hideout in the station, he plots
his takeover of the airwaves. The Super Solvers have been
called in once again to put a stop to his pranks.

As a member of the Super Solvers Club, you'll have only until
midnight to explore the TV station and find the Master of
Mischief’s hideout. It’s in one of the rooms—but which one?
To find out, you must explore the station carefully for clues
and pieces of secret code, while avoiding the Master of
Mischief’s two helpers-Telly the robot and LiveWire—who will
go to shocking lengths to stop you. Use your zapper to protect
yourself, and your official ¢lub decoder to match the clues with
the secret code to figure out which room conceals the hideout.

Life as a Super Solver is challenging, but whether in Midnight
Rescue! or OutNumbered!, you'll be rewarded with higher and
higher ranks—from Trainee all the way up to Champion—the
more games you play. And the more games you play, the
higher your total score and the better your chances of putting
an end to the Master of Mischief's pranks. So, are you ready
for your first assignment? Then welcome to the club!
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Getting
Started

OUR SEARCH FOR THE MASTER OF
MISCHIEF starts here with instructions on loading
the program, choosing a game, and using the game’s
menu bar. And you learn how to sign in as a member
of the Super Solvers Club, since only members can
track the Master of Mischief!




GETTING STARTED

STARTING THE PROGRAM

Before you start the program for the first time, it’s best
to make a backup copy of the program disk(s). For
instructions on how to make a backup copy of a disk
using the DOS (Disk Operating System) command
DISKCOPY, see your DOS manual.

The most efficient way to run the program is to install
(copy) it on your hard disk, if you have one. See
Appendix A of this user’s guide for instructions. (If you
are using Tandy DeskMate™ | see the procedures in

Appendix B.) If you don’t have a hard disk, you can run

the program from a floppy disk.

To run the program from a floppy disk:

1. Put your DOS disk (version 2.0 or higher) in
drive A of your computer and close the disk drive
door. Turn on the monitor and then the computer.
(If DOS is in your computer’s permanent memory
or on a hard disk, or if your computer is already up
and running, you don’t have to insert the DOS
disk.)

2. If you see the prompts for entering a new date and
time, just press [, | Enter|on your keyboard twice.

3. When you see A:> on your screen, remove the DOS
disk and insert the program disk (Disk 1 if you’re
using 5.25" disks) label side up in drive A. (If you
see C:> on the screen, insert the program disk in
drive A, type A: and press )

4. Type SSO and press .| Enter]. In a few moments,
the title screen will appear.

Signing In

S Press to continue and read the messages

on the screen about playing the game. Keep

pressing until you see the Club Member

Sign-In screen or the screen for entering your name.

SIGNING IN

Since only members of the Super Solvers Club can play
the game, you’ll need to sign in before the game starts. The
Club Member Sign-In lists all the
current club members and their

ranks and lifetime scores. Ifthisis [} | €lub Member Sign=In
i A e -3 T
the first time you’ve used the pro- [ff : otstte L
, i Expart 1e3,110
gram, you’ll need to enter your [1heony koo 95,450
[ Parks ”;,'":,',': zg:(’l;g
name as anew member (see step2 |f : I‘.".:mi. ."u.:t.., ba ke
5 2 3 I~
of the instructions below). If this |gexmmemm 2T KT

is the first time you’ve played the

game but others have used the program before, you'll need
to add your name to the list. If you’ve played the game be-
fore, you’ll need to select your name from the list. (If you
want to remove a name, rank, and score from the Club
Member Sign-In when there are fewer than 10 members
listed, see Special Keys in Quick References.)

To add your name to the list:

1. Use[l]or[T]to highlight New Member (if it isn’t
already highlighted) and select it by pressing
. Enter]. (If 10 members are already on the list,
you will be asked if you want to remove a name so

you can add yours. Press to continue.




GETTING STARTED Choosing a Game

Use [ L ]or|T]to highlight the name you want to re- CHOOSING A GAME
move and press to remove it. Read the

message warning you that the member’s name and
score will be erased from the disk. Removing a
name will permanently erase the player’s name,
rank, and lifetime score from the disk.)

After you sign in, the game menu appears with a list of
three ways to play QutNumbered!

Choose Regular Game to play

s 2. Type your name—up to What do you want to play? |

the full game in the standard

Type your name in the box belous eight characters. If you Regular Game

Then press (BEnter). ; way. Here,you’llcxplore the [Customized Game
make a mistake, use : Customized Drill for Skill
TV station, encounter Telly
Backspace |to I k (Esc) to Go Back
— (Fs9) to Go Back the robot and LiveWire the

erase and type again. ! electric cord, solve math challenges (word problems) to

When you're finished, press|.J Enter|. The | i 7 : )
game n};cnu will 'lp])C'll'I ' j collect clues, and answer Telly’s drill questions to capture
iy i secret code. In this game, the level and type of math

. ’ roblems change automatically as you move up in rank.
To select your name from the list: p Bt ¢ Y Aoy l F

L. Use(T]or(l]to highlight your name and press
< Enter|to select it and see the game menu.

Choose Customized Game to play the full game using
the level and type of math problems you want. (See
Customizing the Game in the next chapter to learn more
about changing the settings.)

Choose Customized Drill for Skill to practice basic math
facts. Here, Telly gives you math drill questions to
answer. Like the full game, the clock Keeps ticking
when you answer drill questions. Unlike the full game,
you’ll see how many questions you try and how many
you answer correctly, and you won’t earn any points or
move up in rank. (See Playing Drill for Skill in the
next chapter.)




GETTING STARTED

To choose a game:

1. Use|l]or|T]|to highlight what you want to play
and press to select it. If you played a
regular or customized game before and didn’t finish
it, you’ll be asked if you want to continue that game
which was saved on the disk. Use|«|or|—|to
highlight Yes or No and press to select it.
If you select Yes, you'll start the game where you
left off in the previous game. If you select No,
you’ll start a new game and any points you earned
in the saved, unfinished game will be lost.

2. If you chose Regular Game, read the message on the
screen and press |, | Enter| again to start the game.
If you chose Customized Game or Customized Drill
for Skill, a customization screen appears. See
Customizing the Game and Playing Drill for Skill in
the next chapter for more information. If you win
the full game, the points you earn in this game will
be added to your lifetime score,

USING THE MENU BAR

When you play a game or Drill for Skill, you’ll see the
menu bar at the top of your screen. From the menu bar,
you can get help; see your lifetime score, rank, and the
10 highest game scores; choose to play another game
and start a new player; exit the program; and turn off or
on new user messages, the music, the sound, and the
calculator. (Not all of these options are available in
Drill for Skill.)
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Using the Menu Bar

To make a selection from the menu bar:

1. Press the function key [F1], (F2], or [F3]that appears
on the menu bar to select that menu. A menu
appears with more choices.

2. Use|l]or| T to highlight the choice you want and

press to select it.

3. To leave a menu and return to the game, press [Esc .

Help
Select Help (press ) when you [Help Fi

: Using the Keyboard
want help using the program. Select T TR

the topic you want from the Help |capturing Secret Code

menu and read the information that [EeMecting Clues
Using the Calculator

appears on the screen. Ifthereismore |Winning the Game

. . . /. Moving Up in Rank
information on that topic, press Playing Drill for Skill

(J EnterJto select See Next Page. To 3¢ to Go Back

goback, select Go Backa Page. To get

help on other areas of the program, press El Jorselect Done
to see the Help menu again. When you are finished, select
Esc|to go back

Done to go back to the Help menu or press
to the game.

File

Select File (press) when you want to

see the lifetime scores and the high game  |ekhahibb il i
LT Her gamaietart "o ne High Game Scores

scores, play another game, start anew |g2, grother Game

player, or exit the program. When you |Start New Player

play Drill for Skill, the lifetime scores |Exit and Save

and high game scores are not available, | [ES€) to Go Back

so you will not see them listed on the File

menu.




GETTING STARTED

Choose Lifetime Scores to see the total scores of all the
current club members and their ranks. Your score in a
current game will not be added to your lifetime score
until you win the game. Choose High Game Scores to
see the ten highest scores ever earned in single games
by club members who have played using your disk.

Choose Play Another Game when you want to stop the
game you are currently playing. If you are playing the
full game, you will not be able to save your game score,
so the program will ask if you really want to start a new
game. Select Yes il you do or No if you change your
mind. If you select Yes, you will then see the game
menu.

Choose Start New Player when you want to stop the
game you are currently playing and let someone else
play. In the full game, your game, score, and rank will
be saved so that the next time you play, you can con-
tinue the game where you left off. In Drill for Skill,
your customized settings are saved and will be dis-
played the next time you play. When you are asked if
you want to start a new player, select Yes if you do or
No if you change your mind. If you select Yes, you will
then see the Club Member Sign-In.

Choose Exit and Save in the full game or Exit the
Program in Drill for Skill when you want to stop play-
ing QutNumbered! When you are asked if you want to
exit the program, select Yes (or No if you change your
mind). When you leave the program from the full

Using the Menu Bar

game, your game is saved where you left off. The next
time you sign in, you will be asked if you want to con-
tinue this game or start a new one. When you leave the
program from Drill for Skill, your customized settings
are saved and will be displayed the next time you play.

Options

Select Options (press ) when you
want to turn off and on new user mes-
sages, the music, the sound, or the cal-

New User Messages
Music

Sound

Calculator

culator. When you play Drill for Skill, (Esc) to Go Back

new user messages and the calculator are not available, so
you will not see them listed on the Options menu.

When you start QutNumbered!, the music and sound
are on. In the full game, new user messages pop up for
players ranked as Trainees and the calculator is dis-
played when solving math challenges. When you make
a choice from the Options menu, you will be asked if
you want the option on or off. Select No to turn an
option off. Select Yes to turn it on.

Choose New User Messages to turn the messages off or
on. These messages are special prompts and hints that
appear on the screen from time to time to help new
players learn how to play the full game. The messages
appear automatically only at the Trainee rank. If you
want to see them at higher ranks, you can turn them on
again.




GETTING STARTED

Music

Do you want the
Music on?

to Go Back

Choose Music to turn the music off
oron. If you turn the music off, you
will still hear some special sound
effects.

Choose Sound to turn all the pro-

gram’s sounds, including the music, off or on. If you
turn the sound off, the game is completely quiet.

Choose Caleulator 10 turn the calculator off or on for

solving math challenges. If you turn the calculator on,
you’ll see it when math challenges are displayed and

can use it to help you solve them, If you turn the calcu- i
lator off, you'll need (o solve math challenges with

pencil and paper or in your head and then Llype your
answers in the answer box,

10
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Playing
the Game

STRANGE THING HAPPENED when the
folks of Shady Glen sat down to watch the evening
news. The grinning face of the Master of Mischief
flashed across the screen, then everything went
blank. The Super Solvers Club is out to find the
Master of Mischief and put a stop to his nonsense,
but it won’t be easy. With Telly and LiveWire to
help him, you’re outnumbered before you begin!
And time itself is running out. Better turn the page
and get your instructions from the club . . . before
it’s too late!

11




PLAYING THE GAME

TV TAKEOVER!

News Flash!

This just in: The Master of Mischief is trying to take
over SGTV, the Shady Glen TV station. Blackouts of
regular TV programs are being reported, and power
problems are widespread. The puzzled people of Shady
Glen are demanding help from the Super Solvers
Club—the best thinkers and problem solvers around.

We go now to Shady Glen to report live from the Super
Solvers Club headquarters where club members are
receiving their final instructions.

“We know that the Master of Mischief is hiding out

somewhere inside the TV station. The only way to find

him is to beat him at his own game: numbers. By solv-

ing his math challenges in each room, you’ll collect
e clues to help you figure out if his

-

‘@, _"Et hideout is in that room. Some of his
challenges are tricky, so think care-
fully and use your calculator, if you choose. And
remember club rule number 1: Check your answers!

“We also know that the Master of Mischief is not alone.
Together with Telly the robot and LiveWire the electric
cord, he has you outnumbered! Luckily, you’ve been
trained in acrobatics, 0 you can outjump and outrun Telly
and LiveWire. But when things get hot, you’ll need to use
your zapper. One zap will make LiveWire disappear and
sometimes Telly, too. But there’s more to Telly than

TV Takeover!

meets the eye. This robot carries secrq code that will help
lead you to the Master of Mischief’s hideout.

To capture pieces of code, use your lzup‘;:iclll‘ ”
when Telly is lit up and then answer the dr oyl l \ \
questions )t/hat appear in Telly’s belly. But
watch your step. Telly can’t always be
trusted! So keep in mind clubrule number 2:

Stay alert!

“Whenever you want to think things through and see
how you’re doing, use your decoder. It will show you
all the clues and secret code you’ve collected. Not only
will you be safe from Telly, LiveWire, and the Musl'cr
of Mischief himself, but the clock will stop u‘nd you'll
have plenty of time to study your findings. S0 use your
decoder often, and don’t forget club rule number 3
Think before you act!

«And one more thing. If you follow the rules, you'll
score a lot of points and save the TV station. And when
you earn the rank of Champion, you'll have i chance 1o
turn the tables on the Master of Mischiel!

“Everything you need to know is right here in l‘lih'
guide. Guard it with your life. If the Master of Mis
chief gets it, you’re lost and so is SGTV. And just so
you know what to do, there’s a game plan on the next
page you can carry with you.

“Ready? Then get going. You've got a challenge
ahead of you!”

13



PLAYING THE GAME

Moving Around the TV Station

The Game Plan

®m Look for math challenges in the rooms by
moving up to maps, charts, monitors, and
other interesting objects. Solve the math
challenges carefully to collect clues about the
rooms.

m Zap Telly with your zapper to protect your-
self and to capture secret code that will help
you find the Master of Mischief’s hideout.

m  Use your decoder often to study the room
clues and secret code you've collected. Match
the room clues to the secret code to find out
which room the hideout is in,

m Watch the clock and energy meter. The
clock starts at 9:00 pm and runs until 12:00
midnight. At midnight, it's all over. The
energy meter starts half full. When you get
low, find the energy supply and get more
energy for your zapper.

®m Earn high scores by solving math challenges
and answering Telly’s drill questions, keeping
extra energy in your zapper, avoiding crashes
with Telly and its tricks, zapping LiveWire
before it charges you, collecting your clues
and secret code quickly, and finding the
Master of Mischief’s hideout before midnight.

MOVING AROUND
THE TV STATION

You have a whole TV station to explore—two full floors
of rooms—and not much time to do it. So getting around
the TV station quickly is important, especially witl'1
Telly and LiveWire on your tail! Here are some hlnt.s on
ways to move to stay out of trouble and make good time.

To move left and right: o e
| Pressand. Hold the  |[F7H[ nggM
key down to continue walk- Ejﬁ_ﬁﬁ.ﬂﬂﬁ_r i
ing in that direction. I

To flip and move left and right
quickly:

[ | Press or at the same time. You

can also leap over Telly and LiveWire using
these keys.

To open a door, use the elevator, find a math chal-
lenge, get energy, or jump up when Telly throws
something at you:

m Press(T].

 «Better remember which rooms you've alread‘yv .
~ explored and which ones you still need:clqg_s '
~ for. (If you don’t remember, use your decod .

~ Searching the same hallways and rooms again
~ wastes time and gives Telly and LiveWirea
 petter chance to play their tricks on youl’—

" Don, Senior, Super Solvers Club Member

15



2 PLAYING THE GAME

ENCOUNTERING
TELLY AND LIVEWIRE

You’ll soon discover that the Master of Mischief’s
helpers can be very tricky. LiveWire can be quite
shocking, and Telly is known for throwing such tricks

as laser beams, bolts of energy, and even compact discs.

But Telly can also help you. If you know how to deal
with these two, you'll save time and score more points.
Whenever Telly or LiveWire appears on the screen, you
can use your zapper, answer Telly's drill questions if
they appear, or stay out of harm's way.

Using Your Zapper

Probably your best defense against Telly and LiveWire
is your zapper. When your zapper’s energy touches
Telly when its belly isn't lit, Telly will disappear. But
if Telly’s belly is lit up (red on color monitors), you’ll
be given drill questions to answer. (See Answering
Drill Questions below,) When energy from your
zapper touches LiveWire, it will disappear for a while
and leave you alone,

You’ll need to be careful with the energy in your
zapper. You lose some whenever you use your zapper
or run into Telly or LiveWire. Although you can get
more energy from the energy supply in the hall, you’ll
need to solve a new math challenge first. Otherwise,
the machine may be empty. At the end of the game,

Encountering Telly and LiveWire

you’ll get bonus points for any energy left in your
zapper, so keep an eye on the energy meter. (See
Scoring and Ranking.)

To use your zapper:
B Press . Ifits
energy beam hits Telly
(with an unlit belly) and
LiveWire, they will disap-
pear and stay out of your
way for a while.

To get more energy:
W Find the energy supply and press [T/, If the
machine is empty, solve a math challenge and
come back and try again.

“Don't be afraid to get close to Telly or LiveWire.
If you're too far away, your zapper won't rqach.
~ But then again, if you get too close, you might
~ get bopped!"—Betsy, Junior, Super Solvers
Club Member

~ “Whenever | solve a math challenge, I'm always
~ on the lookout for the energy supply, even if 'm
not running low. That extra energy is worth a
lot of points at the end of the game!l’—Jerr
A Super Solvers Club Member

17




PLAYING THE GAME

Answering Drill Questions

When you zap Telly when its belly is lit up (red on
color monitors), you’ll need to answer math drill ques-
tions. If you do a good job, you will capture a piece of
secret code that can help you find the Master of Mis-
chief. You’ll also score 50 points for every question
you get right and 100 points for each piece of code.

The number of drill questions you get each time you
zap Telly depends on your rank. You can only miss
one question and still capture a piece of secret code.

Drill Questions | Correct Answers
Ral.]k ' Given Needed
Tral.nee and Junior 4 questions 3 answers
Senior and Pro O questions 5 answers
Expert and Master ¥ questions 7 answers
All-Star and Champion | 10 questions 9 answers

As you move up in rank, the drill questions become
more difficult. You can change the type and range of
drill questions you get by customizing the game. (See
Customizing the Game.)

To answer a drill question:

I. Press|Spacebar |to zap

Telly when its belly is lit
up. You’ll get a close
look at Telly’s screen and
the first drill question.

Encountering Telly and LiveWire

2. Answer the drill question by using the number
keys on your keyboard. Work as quickly as
you can, since the clock ticks on. If you make
a mistake, press or [DLU to erase
and try again. If the answer is greater than 9,
type in the numbers from left to right. Then
press . If your answer is correct,
you’ll get another question. If it is incorrect,
the correct answer appears before the next
question comes up. If you miss more than one
question, you’ll need to catch Telly and try
again later. If you get all of the answers right
or all but one of them, Telly gives you one of
four pieces of secret code. It is quickly saved
in your decoder.

“If Telly trips you up on drill questions, play a
few rounds of Drill for Skill. The extra practice
will make you unbeatable!"—Molly, Master,
Super Solvers Club Member :

Dodging Danger

Since Telly and LiveWire are charged with electricity,
you’ll want to avoid crashing into them at all costs.
Each crash will cause you to lose energy from your
zapper. You’ll also have to look out for flying
objects—things thrown by Telly to scare you into leav-
ing the TV station. Not only will each trick knock you
down and make you dizzy, you'll lose 15 minutes off

the clock.
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PLAYING THE GAME

These mischief makers are tough. So here are a few
tips on how to stay out of their way.

To stay clear of Telly and LiveWire:

m Jump over them with a flip
by pressing or
[T](>]. These keys will
also help you outrun Telly
and LiveWire.

®m  Duck into a room or
elevator by pressing | T .

B If LiveWire is after you or Telly throws a trick
at y()lvll‘j‘l.‘l{rnl) up to avoid it by pressing @

~ “When Telly's belly is not lit up, it's better to

~ dodge than zap. Otherwise, you'll justbe
- wasting your energy!"—Stewart, Junior, Super
| rs Club Member .

“Flipping over Telly and LiveWire is a great trick
when it works, but be carefull It works fine with
but you could easily crash rightinto
Lisa, Champion, Super Solvers Club

20
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Solving Math Challenges for Clues

SOLVING MATH CHALLENGES
FOR CLUES

Next to videos of his baby pictures, the Master of
Mischief’s favorite thing is numbers. The numbers on
the game show spinner, the speed of video tapes, and
the temperatures on the newsroom map are all fair
game for this math whiz. But you can stop this showoff
in his tracks with your own math skills. Just solve the
math challenges (the word problems) the Master of
Mischief has left for you in the rooms, and you'll get
the room clues you need to find his hideout.

Take all the time you need to read and solve the math
challenges. If you like, you can use the calculator to
help you. The clock stops while you are working and
Telly and LiveWire won’t come near you. For every
answer you get right on the first try, you'll score extra
points. But if you miss, try again. You'll still score
points for solving the challenge. (See Scoring and
Ranking.)

Every room in the TV station has four clues. The
number of room clues you get each time you solve a
math challenge depends on your rank. The number of
challenges in each room also depends on your rank.

\ ; '7 Room Clues Challenges |
| Rank J per Challenge per Room i
Trainee, Junior, 4 clues 1 challenge

|
| Senior, and Pro Wi

Expert, Master, All- | 2clues 2 challenges |

| Star, and Champion ] ‘

21



PLAYING THE GAME el e BB R
As you move up in rank, you’ll need to solve more keyboard and then press ' eoure
math challenges in each room to collect all the clues. ; using a numeric keypad, you won‘t nee.d [9 L
And the math challenges become more difficult. You | totype ngmbers.) i youn» HTW? ¢
can change the type of problems you get by customiz- j right, you will earn points/anGiESEESSSlE s & 'ou(ti
ing the game. (See Customizing the Game.) the room. If you are wrong, press{ilinter]; an

try again. If you miss a second tim.e, press .

| to get a hint and try again. If you miss a
| third time, the correct answer appears and you
won’t earn any points. But you’ll still collect clues
' about the room. :

‘ 4. Press to go back to the TV station.

“When you can 1 flnd any math chalienges m a
~room, don't worry. It probably means that
. youve already collected all the clues for that
~ room. Go to your decoder to find out.”— .
' Tomm y, Expert, Super Solvers Club Member

ir answer, work the
__To solve a math challenge: ‘ Lif \{problem agam before pfessmg (JEnter].
L. Search the rooms of the TV station for . Your " get the most pomts or getting the
answer right the first time.”—Vanna, Pro,

maps, charts, monitors, and other interest-
ing objects. Press | 1]to see if the Master
of Mischief has left a math challenge

"' Super Solvers Club ‘M_ _ mber

there,
: 2. When you find a math challenge, read it . th |
e Calculator
...... s caluully and think it through. The clock USIng 3 Wl | e S eed
stops when you're working, so take your time Once you’ve figured Outt]:‘/hatr(‘)‘;i‘c’l:']"‘;"(')‘l’l'fvyc e
solving the problem. If you like, use the calculator and know how to Set;:p eﬂ? hall ‘n.’c BHien 3 it oan
to help you complete the answer. (See the instruc- hard part of solving t e m|d| L é “:/Cf l"-M gy
tions on the next pa;,( for using the calculator.) use your ca!culator.to h|~u' t m an i { ..t ;na e
3. When you think you've solved the challenge, check lose any p.omts or tlm(? 1()l.lyl.'~:l;\’11:',‘ll. and i y
. your answer. If you are using the from making arithmetic mistakes.
calculator, press __l Enter| when : \
the answer is displayed. If you You can do just about everything with the calculator
| : t four things:
are not using the calculator, type SRS
the answer in the answer box B You can’t type or calculate numbers larger than
{ OC
using the number keys on the 9999.
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PLAYING THE GAME

B You can’t type decimals or use answers from
the calculator that are not whole numbers. If
the answer to a division problem is not a whole
number, the calculator displays an “r”’ to tell
you there is a remainder.

B You can’t type or calculate numbers that are
negative. That means you can’t subtract a
larger number from a smaller one.

B You can’t divide a number by zero.

To use the calculator:

1. When a math challenge is displayed on the screen,
the calculator appears in the lower right corner of
the screen. (If you don't see the calculator, press
and make sure the calculator is turned on. )

2. Type the first number you want to work with by

pressing the number keys on the
keyboard, If you make a mis-
take, press | Backspace or [Del]
(O erase and try again. Then
press [+ to add, [Z]lo subtract,
[ [to multiply, or to divide.
(You may need to hold down
while pressing these keys to get the symbol
you want.) The symbol will show on the calculator.
3. Type the next number you want to work with. Then
press (=] (or (E| for Iquals) to calculate the answer.
If you are wmkmg with more than two numbers,
press (+), (=], [*], or | /] and then type the next
number dnd press [ = |again.
4. If the answer that appears in the calculator doesn’t
seem right, press [C|to ng.u it and start over.

When you're ready, press [ | Enter]to see if your
answer is right.
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Finding the Master of Mischief’s Hideout

“Watch out when using the calculator to solve

- m‘athbhallengés at the volume machine in the

the answer to the questnon After calculating
~the new volume level, press (C] to clear

~ (erase) the answer shown on the calculator.
- Then type in the number that answers the
. ;-jquestfon and press [ Enter)."—Alexander,

:All~8tar Surper Solvers Club Member

FINDING THE MASTER
OF MISCHIEF’S HIDEOUT

The Master of Mischief is quite a whiz at math, so he's
eager to challenge your math skills. He'll find out how
good you are at solving problems to uncover room
clues and capture secret code from Telly, and whether
you can use them to find his hideout. When he also
finds out how sharp your thinking skills are, he’ll know
his days are numbered!

Your decoder shows you all the room clues and pieces
of secret code you’ve collected so far. By studying
your findings and thinking things through, you"ll bfa
able to figure out which room the Master of Mischief
has his hideout in. So take some time to look things

over. The clock stops when you're using your decoder,

and Telly and and LiveWire won’t bother you.
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PLAYING THE GAME

Using Your Decoder

After ypu’ve solved a math challenge or succeeded in
answering a set of Telly’s drill questions, use your
decoder to see the room clues and secret code you’ve
co!lected. To find the room where the Master of Mis-
chief has his hideout, you'll need to compare the seckret
code objects you've captured from Telly with the room
clue objects you’ve collected in each room. The rule

for matching the secret code to the room clues depends
on your rank.

Rank

If the Secret The Hideo
ut
Match Rule Code is: Room Clue is:

Trainee, Junior,
Senior, Pro

Same objects,

same pilll(‘l'll K@‘amn‘ Kﬂ‘am

Expert, Master

Same objects,

different pattern (- DICAEY] [ OB O~

All-Star, Champion

Different objects,

same patiern Kan ‘ﬂ K@‘g M@

“l use my decoder to see if | have enough
- clues and secret code to decide which room

 the Master of Mischief has his hideoutin."—
Sarah, All-Star, Super Solvers Club Member

Finding the Master of Mischief’s Hideout

To use your decoder:

1. Press(Tab]to use the decoder. (b
You'll see all the room clues i
you’ve collected so far foreach
room and all the pieces of secret. (i ml‘.{"{;,'_“imf
code you've captured from N
Telly. e

2. Press[—] or[<]to highlight
the Match Rule button and press (] Enter] to select
it. You’ll then see the rule to use to match the
secret code to the room clues. Press [lfg\lu] when
you're ready to continue.

To return to the TV station:

1. Press o press (<] to highlight the TV Station
button and press to select it.

Making Decisions
about Rooms

As you look at your decoder, you'll see right away that
some of the rooms can’t be where the Master of Mis-
chief has his hideout—one or more of their clues won't
match the secret code. You'll also find some rooms
where his hideout might be, but you'll need more room
clues or pieces of secret code 1o find out for sure. Once
you’ve collected enough picces of code and enough
clues to figure out where the Master of Mischief’s
hideout is, you’re ready to make a decision,
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PLAYING THE GAME

To make a decision:
1. Use your decoder to study your secret code and

room clues. You need either

Gy o101/ all four pieces of code and at
I.f’ui\ 3 least one set of room clues, or

?cji[o]r;lm all five sets of room clues and

at least one piece of secret
code before you can make a

decision.

2. When the clues of one room match the secret code,
press (L] or [T ]to move the highlight (red on color
monitors) to the clues for that room .

3. To make a decision about that room, press (-] to
highlight the Decide button. Then press | . Enter
to select it. You will be asked if that is the room
where the Master of Mischiel has his hideout.

4. Select No if you changed your mind or aren’t sure
about the room. Select Yes only when you are sure
that that room is where the Master of Mischief’s
hideout is.

~ “| figured out which room the Master of Mis-
chief had his hideout in without even having all
the clues for that room! When | saw that all the
other rooms had at least one clue that didn’t
match the secret code, | knew the room with

the missing clue had to be the Master of
Mischief's hideout."-—Becky, Master, Super
Solvers Club Member
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‘ Finding the Master of Mischief's Hideo%
|

When you select Yes, you’ll be warned that if you con-

tinue, the game will be over whether you are right or

wrong about the room. If you change your mind about

continuing, select No to go back
to your decoder. If you'select Yes
to continue, you’ll return to that
room and see if the locked door
inside opens. You’ll soon learn if
you’ve found the Master of
Mischief’s hideout.

If you’re right, you’ll score bonus points for any extra
time and energy you have, and for finding the right
room. (See Scoring and Ranking.) The points you win
will be added to your lifetime score and saved on the
disk. When you reach the rank of Champion, you'll pel
to turn the tables on the Master of Mischief. If you're
wrong, you won'’t get to keep your points from this
game, but you can always play again.
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SCORING AND RANKING

How are you doing against the Master of Mischief?
Are you doing as well as the other members of the
Super Solvers Club? You can find out at any time b
looking at your scores and rank. .

Scoring

Every time you win a game, your new game score is
afided to your lifetime score and saved on disk. The 10
highest scores ever earned in a single game by club
members using your disk are also saved on disk.

To see your scores during a game:
B Press |[F2|to see the File menu. Then select
Lifetime Scores (o sce your total score and the
total scores of other current club members.

Select High Game Scores to see
the all-time highest single-game
scores made by any members
using your disk. (The points
you've earned in a current game
will not be listed until you win
the game.)
m Tosce your current game score while playing a
game, just look at the score box in the lower-
right corner of your screen.
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Scoring and Ranking

To see your lifetime score at the end of a game:
m When you win a game, your rank and lifetime
score appear on the on-screen trophy.

The best way to get a high score is to solve the math
challenges correctly on the first try. But even if you
don’t, you'll still score points for solving challenges on
the second or third tries. Another way to increase your
score is to get bonus points at the end of the game.
You’ll get bonus points for having extra energy in your
zapper, for having time left over on the clock, and for
winning the game. The number of points you get for : §
each depends on your rank. ‘

POINTS EARNED

RANK  [1st Try [2nd Try 3rd Try
| Trainee T 0, 970 | e A
| Junior 300 200 100
Senior
Expert
600 400 200

Extra Energy | Extra Time
~(per unit) |(per minute)

 Winning
the Game

|
\

100 1000

Master

Another way to get a high score is to answer Telly’s
drill questions correctly. No matter what your rank is,
you’ll score 50 points for every drill question you get
right. And you'll earn an extra 100 points for each
piece of secret code you capture from Telly.
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Ranking

As you earn more and more points, you’ll move up to
higher ranks. And finding the Master of Mischief’s
hideout becomes more and more

Points _ Hank
500,000 Champion

difficult. As you move up in
rank, the rule for matching secret

code to the room clues will be
harder, Telly and LiveWire will
el ppear more often, Telly will
throw more tricks at you, and the
math challenges and drill ques-
tions will become more difficult. In addition, Telly and
LiveWire will move faster, you'll need to answer more
drill questions to capture secret code from Telly, and
you’ll need to solve more math challenges to get all
four clues for each room.

300,000 AN-Star
200,000 Master

120,000 Expert

Chris

Game 6,750
Total 1ev,023

60,000 Pro

e

0w A Y

Press (&Enter) to continue,

Here’s what you can expect as you move up in rank.

\ Number of Number of |
! Telly and Drill Math
1 Points LiveWire Questions Challenges
| RANK Needed ~ Speed per Set per Room
| Trainee 0 Slow 4 1
| Junior 5,000 Slow 4 1
| Senior 30,000 ~ Medium 16 1

Pro 60,000 Medium 6 1

Expert 120,000 Medium 8 2

Master 200,000 Medium 8 2 |
| All-Star 300,000 Fast 10 2 ‘
| Champion | 500,000 Fast 10 2
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Customizing the Game

CUSTOMIZING THE GAME

If you like, you can customize the game 0 you can play
it with the type of math problems you select. It’s a
good way to practice math skills that you need help
with; but depending on your settings, the math chal-
lenges and drill questions may not have as much variety
as in the regular game.

A customized game can be saved on disk just like a
regular game, but with the problem-type settings you
select. The points you win in the game are also saved
on disk and added to your lifetime score, allowing you
to move up in rank.

When you customize a game, you can change the
problem type of the game’s math challenges and drill
questions in four ways.

B Level. Choose one of four levels of difficulty
for the math challenges and drill questions.
When you choose a math level, the default
settings for that level appear for all the other
options. The default settings relate to the math
level associated with the following ranks.

Math Level

‘; Rank el
Trainee and Junior
Senior and Pro

' Expert and Master
All-Star and Champion

s
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PLAYING THE GAME Customizing the Game

m Type of Problems. Choose from any of four To customize a game:

math operations for the math challenges and 1. Select Customized Game from the game menu. If

drill questions: addition, subtraction, multipli-
cation, and division.

B Numbers Used in Drill Problems. Choose any
numbers from 0 to 12 to be used in Telly’s drill
questions. (You should choose at least one
number besides 0 to have meaningful problems,
and more numbers (o have variety in the prob-
lems.)

®  Format of Drill Problems. Choose any of
three problem formats to be used in Telly’s drill
questions;: 3+3=77+5=8,and3 +? =8.

“l used to have trouble remembering my multi-
plication facts. Then | signed in under a fake
name-MULTIPLE-and customized the game

5o | got only multiplication and division prob-

~ lems. Now | know my multiplication facts

inside out!"—Paul, Expert, Super Solvers

Club Member
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you didn’t finish your last game, you'll be asked if
you want to finish it before customizing a new one.
If you decide not to play the unfinished game, any
points you earned in that game will be lost. If the
last game you played was a regular game, the cus-
tomization screen appears and shows the default
settings for the math level that goes with your
current rank. (See The Default Settings on the next
page.) If your last game was a customized game,
the customization screen shows the settings used in
that game

press .,.,E,ora to

highlight the option you want Iu.ofl':fﬁ'?og‘?"" e

A4 (xalacts ald

tochange. (Press|Tab|to move Tope ot s
between groups of settings.) ||®sutracton JOmsion

Numbars Used in Dril Problems:
3S @0 @ @2 @3
Thenpress| ] Enter|tochange |[|@o @i~ w2 03

it. If the option was checked, it [|5* Gu iz
Format of Dril Problems:

becomes unchecked. If the [[B3¢3=7 07+5-¢ [O3+7=8

Multiphoation

option was unchecked, it be-
comes checked.

Continue changing all the option settings you want.
Select the Undo button if you want to return to the
original settings. Select the OK button when you’re
ready to start the game using the displayed settings.
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The Default Settings

The chart below shows the default settings for the
customization options at each level. Notice that at level
4, all problem types, all numbers from O to 12, and all
the drill formats are selected.

‘ Numbers

‘ Math Problem Used in Drill Drill

| Level Type Questions Format

T Addition (casy) 012345 3+5=7 |

‘ Subtraction (easy)

‘ 2 Addition (hard) SRR RARsE 613 5 = 9

‘ Subtraction (hard) 8 10 74+5=8

, Al S+0=8 |

'3 Addition (hard) zeas - [3+5=2

3‘ Subtraction (hard) 678910 ‘
Multiplication (casy) |
Division (easy) ‘

4 Addition (hard) [0 123456 [3+5=?7 |

Subtraction (hard) RBRORI0N 1T 12 [24+5=8 |
Multiplication (hard) 3+72=8 |
Division (hard) \
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Playing Drill for Skill

PLAYING DRILL FOR SKILL

Would you like to practice some of your math facts?
Then play a few rounds of Drill for Skill and sharpen
your math skills. With a little practice, you may even
beat the Master of Mischief at his own game!

Drill for Skill is very much like
Telly’s drill questions in the full
game, but Drill for Skill keeps
track of the number of questions
you've tried and the number you
answered correctly. And unlike
the full game, you won’t earn any
points, so your rank won’t change.

When you play Drill for Skill, you can change the
problem type of the drill questions in four ways.

® Number of Problems in Each Set. Choose one
of four sizes of problem sets: 5, 10, 15, or 20
problems per set. The very first time you play
Drill for Skill, the setting for the number of
problems in each set relates to the math level
associated with your rank in the game. The
settings of the other options are the same at that
level as those shown for the game in The De-
fault Settings on the previous page.
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[ Math Problems
Rank Level per Set
Trainee and Junior 1 5
Senior and Pro 2 10
Expert and Master 3 15

~ All-Star and Champion | 4 20 "

B Type of Problems. Choose from any of four
math operations: addition, subtraction, multi-
plication, and division.

® Numbers Used in Drill Problems. Choose any
numbers from 0 to 12 to be used in the prob-
lems. (You should choose at least one number
besides 0 to have meaningful problems, and
more numbers to have variety in the problems.)

®  Format of Drill Problems. Choose any of
three problem formats to be used in the prob-
lems:3+5=77+5=8,and3 +?=8.

To play Drill for Skill:

1. Select Customized Drill for Skill from the game
menu. If you haven't played before, the custom-
ization screen appears with the default settings for
the level of difficulty that goes with your current
rank in the game. If you have played before, the
customization screen appears with your current
settings.

O

Playing Drill for Skill

2.

@

To change the settings on the customization screen,

press|L],|T],|<], or|=/to highlight the option you

want to change. (Press|Tab|to
g ( Customizc Drnw !

move between groups of set- Renber of Probisms T Each Sa

tings.) Then press[J Enter] to [|ups ot provems:

change it. If the option was ||ESuwtractn i Shetaion
Numbers Used in Dril Problems:
checked, itbecomesunchecked. [|&2 "8 HeuuEs &4
If the option was unchecked, it [|T%° Ot B
becomes checked.
Continue changing all the R -
option settings you want. Select the Undo button if
you want to return to the original settings. Select
the OK button when you’re ready to play using the
displayed settings. The first drill question in the set
appears.
Answer the drill question by using the number keys
on your keyboard. (If you’re using a numeric
keypad, you won’t need to press (Num Lock | to
type numbers.) Work as quickly as you can, since
the clock ticks on. If you make a mistake, press
| Backspace ] or [Del]to erase and try again. Then
press | Enter|. If your answer is correct, you'll
get another question. If it is incorrect, the correct
answer appears before the next question comes up.
Continue answering sets of questions until you're
ready to play the full game or want (o stop.

Format of" Dril Problems:
R3+5=2 [1?2+5=8 []a+7=0

E]
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Quick
References

EED ANY MORE INFORMATION on
using the program? Then use this part of the user’s
guide to look things up and get help when you need
it. You’ll find a complete list of special keys and
how they work. And if you have any problems
using the program, go to Troubleshooting for pos-
sible solutions. When you need help fast, go to the
Index at the back of this guide to find what you're
looking for.
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3 QUICK REFERENCES

SPECIAL KEYS

EXPLORING THE TV STATION

A

EY
| or |2

=

(1) @ or (FHome)

(1) &) or (PgUp)

|¢—
-l

Esc

FUNCTION
Moves you left or right. Hold the key
down to move continuously.

Opens a door, operates the elevator,
moves you up to a math challenge,
operates the energy supply, and makes
you jump up when Telly is near (if you
are not in front of a door or the energy
supply).

Flips you up and moves you to the left
quickly.

Flips you up and moves you to the right
quickly.

See [Tab).

Removes new user messages from the
screen.

Lets you stop the game and exit the
program.

42

Special Keys

Exploring the TV Station—continued

KEY

FUNCTION

Sec [ Enter].

Zaps Telly and LiveWire and makes
them disappear; when Telly’s belly is lit
up, makes math drill questions appear.

Displays the decoder.

A
m
<

Backspace

or (Del]

()

WORKING MATH CHALLENGES

FUNCTION
Moves you up to a math challenge.

Erases the last number or symbol you
typed.

Clears all the numbers and symbols you
typed in the calculator.

Enters your answer to a math challenge
or drill question; displays a hint if your
second answer was wrong in a math
challenge.

Takes you back to the TV station.
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Working Math Challenges and Drill Questions—continued USING YOUR DECODER
KEY FUNCTION T
Shift Lets you type the + or * symbol on key- KEY FUNCTION
board 1 i - — P
Z:jlr QR0 Dave 8 numetickey or Cycles through the buttons at the bottom
Pegs of the screen.

Adds the next number you type in the or Cycles through the sets of room clues
calculator. shown in the decoder.
E] Subtracts the next number you type in Selects a highlighted button.

the calculator.
Esc Takes you back to the game.

[+

Multiplies by the next number you type
in the calculator,

it U
Divides by the next number you type in e
the calculator, KEY FUNCTION
«Jor|(— Cycles through the menus.
(=]or Calculates the answer to the math prob- h v
eRLouRypedin the calculator. or Cycles through the menu choices.
Turns the sound off or on in the pro-
gram.
Selects a highlighted menu choice.
Esc Takes you back to where you were in a

menu or the TV station.

Displays the Help menu.
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QUICK REFERENCES Special Keys

Using the Menu Bar—continued

KEY FUNCTION
Displays the File menu.

Displays the Options menu.

g

| SIGNING IN '
KEY FUNCTION Tab
or Highlights a name or New Member on |

the list.

) Enter Selects a highlighted name or New
Member; enters a name you type.

Backspace Erases the last letter you typed when
entering a name.

g
=
E

Lets you remove a name from the list.
These keys let you permanently erase a
player’s name, rank, and lifetime score
from the disk.

FUNCTION
Cycles through options on the custom-
ization screen.

Changes a highlighted setting.
Takes you back to the game menu.
Moves you between one group of set-

tings and the next on the customization
screen.
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TROUBLESHOOTING

INSTALLING THE PROGRAM

PROBLEM

1. When you try to copy
the program to your
hard disk, you see the
message, “A hard disk
is not available” even
though you have one.

SOLUTION

Make sure your hard disk is
properly connected to your
computer. If your hard disk is

a separate unit, make sure it is
turned on.

If your hard disk doesn’t have
enough room for the program
files, delete some files to make
room for the program on your
hard disk.

If you started your computer
with a DOS disk and have a hard
disk set up by a disk manager,
you will need to start your com-
puter from the hard disk.

Troubleshooting

1. You see nothing but a
blank screen when you
load the program.

| USING THE PROGRAM '

PROBLEM

SOLUTION

This may happen on some ma-

chines when you turn the monitor

on after the computer.

« Start over. Be sure to turn on
the monitor before you turn on
the computer.

« If you are using a Tandy 1000
TL, SL, TL/2, or SL/2 com-
puter with a monochrome
(noncolor) monitor, you must
at the same time when you start
your computer. Also, when
you start the program at the
A:> prompt, you must type
SSOH (the H is for Hercules)
instead of just SSO. (See
Appendix B for more special
instructions for Tandy users.)

* If you are using a Tandy
computer with a VGA monitor
and graphics adapter, start the
program by typing SSO -E
instead of just SSO. (Don't
forget the space after SSO.)
This puts your computer in
EGA emulation mode.

If you install this program on the
hard disk of a computer with a
version of DOS lower than 3.0,
one file may not have copied to
the hard disk.

» Use the DOS command COPY
to copy the file SSO.BAT from
the program disk (Disk 1 if
you’re using 5.25" disks) to C:\
(or your hard drive).

2. You see the message
“Bad command or file
name” when you type
SSO at the C:> prompt
(or other drive that is
your hard drive) after
you have installed the
program.
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PROBLEM

2. The game action is
very slow.

3. When using the pro-
gram, you get a message
that the disk is “write
protected.”

SOLUTION

« If you have two graphics adap-
ter cards in your computer, you
must tell the computer which
one to use. When you start the
program, type SSO -E (for
EGA or VGA), SSO -C (for
CGA), or SSO -H (for Hercu-
les) instead of just SSO.
(Don’t forget the space after
SS0.)

If you have an EGA monitor
running on an IBM XT or on any
8088 4.77 MHz Intel machine,
the game will run slowly. The
speed is limited by the rate at
which the computer can process
the information displayed on the
screen. Computer performance
can be upgraded by adding an
accelerator board.

You need to remove the write
protection from the disk. To do
that:

« on a 3.5" disk, slide the tiny
plastic tab down to close the
hole in the upper-right corner
of the disk.
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PROBLEM

4. The arrows on the nu-
meric keypad don’t
work or the numbers
on the numeric key-
pad don’t work.

5. You press (=] when
using the calculator
and you see the mes-
sage, “You must type
(=] before the calcu-
lator can do the next
step of your problem.”

SOLUTION

« on a 5.25" disk, remove the
write-protect tab (tape) from
the notch in the upper-right
corner of the disk.

Keys that have a number and an
arrow on them work as arrows in
the game, but as numbers when
you are answering math chal-
lenges or drill questions. If you

press , you will

reverse the way they work.

* Press |Num Lock |again.

If you are using an IBM PS/2

with a Space Saving keyboard

(a short keyboard with only 84

keys and no separate numeric

keypad)

« press (E]instead of [=].

« To be able to use either B or
, whether you run the pro-
gram from a floppy disk or
hard disk, start the program by
typing SSO S (for Super
Solvers Qut Numbered! Short
keyboard) instead of SSO.
Don't forget to type a space
between SSO and S.
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PROBLEM SOLUTION

6. The game stops suddenly Some Tandy computer keyboards
while you are moving have a HOLD or Pause key
around with the arrow which you may have pressed by
keys. accident.

* Press [HOLD] or [ Pause | again
and continue playing.

If you have any questions, call our Customer Service
Department at 1-800-852-2255.
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AN EDUCATIONAL NOTE

AN EDUCATIONAL NOTE

Mathematical literacy is an essential component of a child’s
education. From basic arithmetic skills to the more complex
tasks of analyzing, structuring, and then solving real-life word
problems, numerical reasoning is as important to understanding
science and technology as reading is to understanding litera-
ture. OutNumbered! offers a richly entertaining environment
where children can master basic math facts, develop problem-
solving strategies, and improve other important thinking skills.
The unique game design promotes learning through play.
Children develop skills necessary for success in school while
gaining an early appreciation of math that will help them make
sense of a complex technical world.

Basic Math and
Problem Solving

OutNumbered! has been carefully designed to develop two

complementary sets of math skills:

W Proficiency with the basic arithmetic operations of addition,
subtraction, multiplication, and division.

B Proficiency with the analytical process of interpreting,
structuring, and solving word problems.

To complete the full game, children must answer timed sets of
drill questions that test their knowledge of the basic number
facts; and they must solve word problems that make use of
dynamic graphs, charts, maps, and other objects that reflect
real-life contexts. The word problems are presented as chal
lenges posed by the Master of Mischief in his attempt (o take
over the Shady Glen TV station. These challenges are found in
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the rooms of the TV station and make use of objects associated
with each room: for example, a weather map in the newsroom,
a volume control in the sound room, and a line graph in the
cartoon room.

The word problems (or math challenges) have been written
using a sophisticated database structure that allows text and
numbers to combine to create thousands of unique, realistic
problems. All of the math challenges yield easy and hard
problems for each of the four operations—addition, subtraction,
multiplication, and division. As children improve their scores
and achieve higher rankings, the level of problems, including
the number and difficulty of the math operations, is automati-
cally adjusted to offer greater challenge. (The chart in Custom-
izing the Game shows how math levels correlate with the
rankings.) However, special customization features allow the
math content to be tailored to individual players’ needs and
skills. For example, the program can be customized for older
children who can handle higher-level math problems but who
are unfamiliar with other aspects of the game, or for younger
children who have not yet been exposed to multiplication and
division but who wish to move up through all of the ranks.

A special program feature, Drill for Skill, permits extensive
practice of basic math facts. Because the range of numbers, the
size of problem sets, and the operations can all be specified,
Drill for Skill is an ideal forum for mastering homework as-
signments or preparing for quizzes. This option also allows
younger children who have difficulty with word problems to
“prow into” the product.

AN EDUCATIONAL NOTE

A calculator option has been provided to speed computation of
word problems once the player has analyzed the question and
the graphic and has set up the problem. Most math educators
advocate such use of calculators in the elementary grades; it
places proper emphasis on the process of solving problems and
introduces children to the calculator as an important mathe-
matical tool. (This option can be turned off and word problems
can be solved more conventionally through use of pencil and
paper or through mental computation.) Since there is no
substitute for mastering basic math facts, the calculator is not
available to players in drill-and-practice sets.

Using Thinking Skills

Each OutNumbered! game contains an overall problem that
players must solve in order to win. Picture clues are awarded
for solving math challenges, and similar picture pieces of secret
code are collected after drill-and-practice sets have been suc-
cessfully completed. These pictures are gathered and organ-
ized into patterns that must be analyzed for a particular type of
match-up, leading to a conclusion about the location of the
Master of Mischief’s hideout. The complexity of the match-up
increases as the level of math increases in the rest of the game.
Over time, children will develop and refine unique strategies
for winning the game.

Children use the following thinking skills while playing Out-
Numbered! Below, each thinking skill is followed by one
specific example of its use in the game.
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Gathering Information—The ability to notice and collect
relevant information through observing external events
and recalling information from memory. Players use
this skill to interpret multicolumn charts and maps to
solve math challenges.

Organizing Information-The ability to order and sort infor-
mation for appropriate retrieval. Players organize
numbers and operations during the structuring process
of solving math challenges.

Analyzing Information-The ability to formulate questions
about information, to recognize relationships between
and among parts, and to discriminate between relevant
and irrelevant points. Players practice this skill when
they study their room clues to determine which rooms
still need to be explored.

Drawing Deductive Conclusions—The ability to weigh sup-
porting and conflicting evidence in verifying beliefs
and assumptions. This skill is exercised when players
compare room clues with the secret code to determine
which room contains the Master of Mischief’s hideout.

Math Facts

The math facts used in the program’s drill questions include the
following ranges of problems.

From To
Addition 0+0 12 + 12
Subtraction 0-0 24 - 12
Multiplication 0x0 12 x 12
Division 0+ 1 144 + 12
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APPENDIX A:
HARD DISK INSTALLATION

If you have a hard disk (fixed disk), it is best to run the pro-
gram from that hard disk. The installation procedure puts a
copy of OutNumbered! on your hard disk. This procedure
creates a special storage area, a directory, on your hard disk
called TLC (for The Learning Company) and another directory
within that one called SSO (for Super Solvers OutNumbered).

Before you continue, be sure you have made a backup copy of
the disk(s) using the DOS command DISKCOPY. (See your
DOS manual for instructions.)

To install the program on a hard disk:

1. When you see the C:> prompt (or another DOS prompt that
identifies your hard disk), insert the program disk (Disk 2 if
you’re using 5.25" disks) in drive A.

2. Type A: and press .
3. Type INSTALL and press again.

4. Follow the instructions on the screen.

To start the program once you have installed it on your
hard disk:

1. At the C:> prompt, type SSO and press ;
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APPENDIX B: Now you can start QutNumbered! by selecting SSO in the
: application list box.
TANDY DESKMATE INSTALLATION R

NOTE: If you have a monochrome monitor, you will also
have to use [F7]to “redefine” the program name to SSOH.BAT

Whether you choose to run QuitNumbered! from your hard disk 1o Fafiheé progHam from DeskMei

or from the program disk(s) that came in the package, you can
customize the DeskMate desktop to make starting the program
quick and easy. By following the instructions below, you can
create a special application list box for QutNumbered! This
will allow you to start the program from the desktop just by
selecting SSO (for Super Solvers OutNumbered).

To customize the DeskMate desktop:

1. Insert the program disk in drive A,

2. Press[F7)to open the Desktop menu.

3. Highlight Install and press .| Enter].

4. When the Display menu appears with SSO (for Super
Solvers OutNumbered) highlighted, press :

5. Use the arrow keys to position the dotted box where you
want it to be. (This will be the application list box for
OutNumbered!) Then press .| Enter]to place it.

6. Press again.

7. Highlight Redefine and press . | Enter]. The Redefine
menu appears. If SSO is not already highlighted, high-
light it.

Press :

9. At the next Redefine menu, tab to the fourth box called

Startup Directory.

10. Then, if you will be running OutNumbered! from
m a floppy disk, type A:\ (or B:)) and press '
m your hard disk, type \TLC\SSO and then press

(o] Enter).

o
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CUSTOMER SERVICE

We are proud of the special relationship we have with many satisfied parents and
teachers. If you have a problem, a question, or a suggestion, please call our
Customer Service Department at 1-800-852-2255 or 1-415-792-2101.

The Learning Company warrants to the original purchaser only that the program
disk(s) provided with this user’s guide and the software program coded on it will
perform in accordance with the descriptions in this user’s guide when used with the
specified equipment. If the program is found defective within 90 days of your
purchase, it will be replaced. Simply call The Learning Company’s Customer
Service Department at the above toll-free number and a replacement disk will be
sent within 24 hours. Replacement of the disk is the full extent of our liability.

This warranty is in lieu of all other warranties, whether oral or written, expressed or
implied. Any implied warranties, including those of merchantability and fitness for
a particular purpose, are limited in duration to 90 days from the date of purchase of
this product.

The Learning Company shall not be lable for incidental and/or consequential
damages for the breach of any expressed or implied warranty including damage to
property and, to the extent permitted by law, damages for personal injury even if
The Learning Company has been advised of the possibility of such damages. Some
states do not allow the exclusion or limitation of incidental or consequential
damages or limitations on how long an implied warranty lasts, so the above
limitations or exclusion may not apply (o you.

This warranty shall not be applicable to the extent that any provision of this
warranty is prohibited by any federal, state, or municipal law which cannot be pre-
empted. This warranty gives you specific legal rights and you may also have other
rights which vary from state to state.

Unauthorized reproduction, adaptation, distribution, performance, or display of this
document, the associated computer program, or the audiovisual work is strictly
prohibited.

Damaged Disk Replacement Policy: The Learning Company will replace disks
that the user damages for a duplicating and handling fee. Return your damaged disk
and a check for $10 to:

The Learning Company

6493 Kaiser Drive

Fremont, CA 94555

Attention: Disk Return Dept.
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A
adapter cards, graphics 49
adding
names of players 3-4
numbers 24, 44
Alternate key ([Alt)) 49
answer box 10, 22
answering
drill questions 13, 14, 18-19, 31,
32, 39,43
math challenges See solving
math challenges
arrow keys (1], (T].[<). &)
list of functions 42-43, 45-47
problems with 50, 51
to
cycle through menus 45
find math challenges 15, 22,
42,43
highlight choices 3-4, 6,7,
27,28, 35, 39, 45, 46, 47
move around 15, 20, 42
avoiding Telly and LiveWire 19-20
award See scores

B
Backspace key (| Backspace |) 4,
19, 24, 39, 43, 46
backup copy 2, 57
blank screen 49
bonus points 17, 29, 31
buttons
Decide 28
Match Rule 27
OK 35,39

buttons—continued
TV Station 27
Undo 35, 39

C
calculating answers See calculator
Calculator 10
calculator 9, 10, 22, 23.25, 4344
capturing secret code 13, 14, 1819,
32
cards, graphics adapter 49
CGA 49
challenges, math 12, 14, 2125, 41,
32,33, 34, 43-44
choosing See selecting
choosing a game 5-6
Clear key ([(C]) 24,25, 43
clearing the calculator 24, 25, 44
clock 5, 13,14, 19, 21, 22, 23; 31}
39
Club Member Sign-In 3, 8
Club, Super Solvers
hints from members 15, 17, 19,
20, 22, 23, 25, 26, 28, 34
list of members 3-4
rules 12-13
clues, room 12, 14, 21-23, 25 2N,
31-32
code, secret 13, 14, 1819, 25 2K,
31,82
collecting room clues 12, 14, 2124,
32
color monitors 16, 14, !4
continuing an unfinished game 6,
9
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Control key ( ) 45, 46, 49
copy, backup 2, 57
crashing into Telly and LiveWire
14, 16, 19, 20

curriculum skills, of program 53-56
customer service 60
customization

options 33-36, 37-39

screen 35, 38-39, 47
Customized Drill for Skill 5-6, 38
Customized Game 5, 6, 35
customizing

Drill for Skill 37-39, 47

Tandy DeskMate 58-59

the game 33-36, 47
cycling through choices 45, 47

D

Decide button 28

decimals 24

decisions about rooms, making 27-
29

decoder 13, 14, 25-29, 43, 45

default settings 33, 35, 36, 37, 38

defective disks 60

defending yourself See encounter-
ing Telly and LiveWire

Delete key ((Del]) 4, 19, 24, 39, 43,
46

deleting See erasing

DeskMate, Tandy 2, 58-59

difficulty level 5, 18, 22, 32, 33-34,
36, 37-38

directory 57

disk drives 2, 48, 57, 58

disk, hard 2, 48, 57, 58

problems with 48

Disk Operating System See DOS

DISKCOPY 2, 57

disks 2,48, 50, 57, 58, 60

Dividekey ((/])24,44
dividing numbers 24, 44
dodging Telly and LiveWire 19-20
Done 7
doors, opening 15, 29, 42
DOS 2,48, 57
Drill for Skill 5, 6,7, 8,9, 37-39,
47
drill questions 13, 14, 18-19, 31,
32, 34,37, 39, 43
customizing See customizing the
game and Drill for Skill
drives, disk 2, 48,57, 58
ducking into
rooms 20
the elevator 20

I
[E] 24, 44
carning
high scores 14, 31
points 13,17, 18, 21, 23, 29, 30-
31, 32
educational note 53-56
EGA 49, 50
clectric cord See LiveWire
clevator 15, 20, 42
emply energy supply 16, 17
encountering Telly and LiveWire
16-20
cnergy 14, 15, 16-17, 19, 29, 31
meter 14,17
supply 14, 16-17, 42
Enter key ([J Enter]) to
change customization settings
35, 39, 47
continue 23, 27
display hint 23, 43
enter answers 19, 22-23, 24, 39,
43
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Enter key ( ) —continued

enter names of players 4, 46
remove new user messages 42
run the program 2-3
select choices 3,4, 6,7, 27, 28,
45, 46
start a game 6
entering
answers to
drill questions 18-19, 39, 43
math challenges 22-24, 25, 43
names of players 3-4
numbers in calculator 23-25,
43-44
Equals key ((=]) (See also(E))
24, 44
erasing
mistakes 4, 19, 24, 39, 43, 46
numbers in calculator 24, 25, 43
players’ names, ranks, scores 3-
4,46
error messages (See also messages)
48, 50
Escape key ( 11723427442,
43,45, 47
Exit and Save 7, 8
Exit the Program 8
exiting the program 8-9, 42
exploring the TV station 15, 42-43
extra
energy 14, 17,29, 31
help 7,9,23
points (See also bonus points)
17,21 29,31
time 29, 31

F

F1 key ([F1]) 7, 45

F2 key ( [I—_’ﬁ) 7, 30, 46

F3 key ({F3]) 7,9, 24, 406

F7 key ([F7]) 58, 59

File 7

File menu 7-9, 30, 46

finding the

Master of Mischiel"s hideout 25
29
math challenges 14, 15, 22,42,

43

5.25" disks 2,48, 50, 57

flipping 15, 20, 42

floppy disks 2, 58

flying objects See tricks

Format of Drill Problems 34, 18

formats of drill questions 34, 36, 18

fractions 24

full game See game

function keys See F1, F2, '3, and
F7 keys

G
game
choosing 5-6
customizing 33-36, 47
menu 4,5, 35, 38
plan 14
playing 11-39
saving 8-9
starting 6, 8
stopping 8-9, 42
winning 29, 30-31
getting
energy 15, 17,42
help 7,9, 22,45
started 1-10
Go Back a Page 7
graphics adapter card 49
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H
hallways, searching See exploring
the TV station
hard disk 2, 48, 57-58
problems with 48
Help 7
help 7,9, 22,45, 46
Help menu 7, 45
Hercules 49
hideout 12-13, 14, 25-29
High Game Scores 8, 30
high game scores 7, 8, 14, 30, 31
highlighting
choices 3, 6,7, 27, 28, 35, 39
names of players 4
hints (See also new user messages)
for solving math challenges 23,
43
from club members 15, 17, 19,
20, 22, 23, 25, 26, 28, 34
Hold key ( ), 82

Home key ( ) 42

I
IBM PS/2 51
IBM XT 50

information on program’s educa-
tional content 53-56
INSTALL command 57
installing
Tandy DeskMate 58-59
the program 2, 57, 58-59
on a hard disk 57
problems with 48
integers See whole numbers
investigating See exploring the TV
station

J
jumping up 15, 20, 42

K

keys
list of 42-47
problems with 51

I
learning objectives of program 53-
56
leaving the program See exiting the
program
left , moving 15, 20, 42
leftover numbers See remainders
levels
game difficulty 5, I8, 22,32, 33-
34, 36, 37-38
math 33, 35, 36, 37-38
Lifetime Scores 8, 30
lifetime scores 3, 7, 8, 29, 30, 31,
33
list of
club members 3-4
keys 42-47
LiveWire 5,12-13, 14, 15, 16-17,
19-20, 21, 25, 32

M

making decisions about rooms 27-
29

Master of Mischief 11, 12-13, 21,
25-29

Match Rule button 27

match rules 26, 32

matching 26, 32
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math

challenges 12, 14, 21-25, 31, 32,

33, 34,43-44
customizing See customizing
the game
facts (See also Drill for Skill) 5,
37, 56
level 33, 35, 36, 37, 38
operations 24, 34, 36, 38, 44
problems See math challenges
and drill questions
skills 21, 25, 33, 37, 53-55
members, club
list of 3-4
number of 3
membership, club See Super
Solvers Club
menu bar 6-10, 45-46
menu choices (See also customiza-
tion screen) 5, 6-10, 30,
35, 38
menus 4,5, 7-10, 45-46
messages 3,4, 6,9, 29,42, 48, 50
midnight (See also clock) 14
Minus key ([-]) 24, 44
mistakes 4, 19, 23, 24, 39,43, 4
monitors 2, 16, 18, 28, 49, 50, 5
color 16, 18, 28
monochrome 49, 59
monochrome monitors 49, 59
moving
around the TV station 15, 42-43
in Help topics 7, 46
left and right 15, 20, 42
up in rank 18, 22, 26, 29, 31, 32
Multiply key ([*]) 24, 44
multiplying numbers 24, 44
Music 10
music 9, 10

6
9

N
names of players 3-4, 46
negative numbers 24
New Member 3, 46
new player, starting 8
New User Messages 9
new user messages 9, 42
No 6, 8,9, 28, 29,
number left over See remainders
Number Lock key ([Num Lock |)
2351393101
number of
bonus points 31
challenges per room 21
drill questions per set 18, 32, 37
pieces of secret code 28
points earned 31, 32
room clues per challenge 21, 32
sets of room clues 28
tries per math challenge 23, 31
Number of Problems in Each Set 37
numbers
adding 24, 44
decimal 24
dividing 24, 44
entering in calculator 23-25
erasing in calculator 24, 25, 43
fractions 24
leftover See remainders
multiplying 24, 44
subtracting 24, 44
whole 24
Numbers Used in Drill Problems
34,38
numeric keypad 23, 39, 44, 51
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Q) program—continued

objectives of program, learning 53- problems with 48-51
56 starting 2-3, 57-58

objects, flying See tricks
OK button 35, 39
opening doors 15, 29, 42
operating the
calculator 23-25, 43-44
elevator 15, 20, 42
energy supply 15, 17,42
Options 9
options
customization 33-36, 37-39
menu 6-10
Options menu 9, 46
OutNumbered! See program

I)
Page Down key ([PgDn|) 46
Page Up key ( 2. 46
pages in Help topics 7, 46
Pause key ( ) 50
plan, game 14
Play Another Game 8
players’ names, adding 3-4
playing

Drill for Skill 37-39

the game 11-39
Plus key ([+)) 24, 44

points 13, 17, 18, 21, 23, 29, 30-32,

33,37
problem solving (See also math
challenges, drill questions,
and thinking skills) 53-55
problem type 33-34, 36, 37-38
program
disk 2,48, 57, 58, 60
exiting 8-9, 42
installing 2, 57, 58-59

prompts
DOS 2,57
program See messages
protecting yourself See encounter-
ing Telly and LiveWire

Q
questions, drill 13, 14, 18-19, 31,
32,34, 37, 39,43

R

R key ([R]) 46

1" on calculator 24

ranking (See also ranks) 32

ranks 3-4, 8, 13, 18, 21, 22, 26, 29,
31, 32,33, 37-38, 46

references 41-51

Regular Game 5, 6

remainders 24

removing players’ names, ranks,
scores 3-4, 46

Return key ( ) See Enter
key

right, moving 15, 20, 42

robot See Telly

room clues 12, 14, 21-23, 25-28,
31-32

running the program See starting
the program

S

S key ((S]) 45

saving
a game 8-9
customization settings 8-9, 33
scores 8,29, 30
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score box 30
scores 3-4, 8, 13, 18, 29, 30-31, 33,
46
scoring and ranking 30-32
scoring points 13, 17, 18, 21, 23,
29,30-31,32
searching the TV station See
exploring the TV station
secret code 13, 14, 18-19, 25-28,
31432
See Next Page 7
selecting
a game 5-6
choices 6-10, 30, 45-47
customization settings 33-36,
37-39
hideout room 28
names of players 3-4, 46
service, customer 60
sets of
drill questions 18-19, 32, 37-38
room clues 28
settings
customization 33-36, 37-39
default 33, 35, 36, 37, 38
SGTV 12-13
Shift key ( [Shift]) 24, 44, 49
signing in 3-4, 46
size of problem sets 37-38
solving math challenges 12, 14, 21-
25,31,32
Sound 10
sound 9, 10, 45

Spacebar key ([Spacebar]) 17, 18,
43

special keys 42-47

speed of
game play, problems with 50
Telly and LiveWire 32

SSO command 2, 48, 49, 57, 5%
Start New Player 8
starting

a game 0, 8

anew player 6, 8

the program 2-3, 57-58
stopping

a game 8-9,42

Telly and LiveWire 1617

the clock 13,21, 22, 25

the program 8-9, 42
storage area See directory
storing See saving
subdirectory See directory
subtracting numbers 24, 44
Super Solvers Club 1, 3, 12:11, 10
support, customer 6()
symbols, math See math operations

T

Tab key () 27, 35,43, 47

Tandy computers 49, 52

Tandy DeskMate 2, 58-59

Telly 5, 12-13, 14, 15, 16:20, 21,
25132

thinking skills 25, 53, 55-56

3.5" disks 50

time See clock

tips See help, hints, and messnpes

title screen 2

TLC directory 57

total scores See lifetime scores

tricks 14, 15, 16, 19, 20, 12

trophy 31

troubleshooting 48-51

TV station 12-13, 15§, 2128, 27,
42-43

TV Station button 27
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type of math problems 33-34, 36,
37-38

Type of Problems 34, 38

typing See entering

U

Undo button 35, 39

unfinished game 6, 8-9

using the
calculator 23-25, 43-44
decoder 26-27,43, 45
elevator 15, 20, 42
energy supply 15, 17,42
menu bar 6-10, 45-46
zapper 16-17

v
V key ([V]) 49
VGA 49,50

%%

warning messages 4, 29

warranty 60

whole numbers 24

winning the game 29, 30-31

word problems See math challenges
write protection 50

Y
Yes 6, 8-9, 28, 29

Z

zapper 12,13, 14, 16-17, 19
zapping Telly and LiveWire 16-17
zero, dividing by 24
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THE LEARNING COMPANY

A leader in children's software, The Learning Company is
dedicated to producing high-quality, engaging products that
enrich the education of young people ages three and up. Our
unique approach reinforces important subject areas, while
helping to develop underlying thinking skills.

At The Learning Company, we also strive to make our products
engaging and easy to use. Intriguing characters, challenging
situations, and rich game environments combine to create
captivating programs that children can enjoy for hours on end.
Multiple skills levels and easy-to-follow directions make each
product accessible to a wide audience—without frustration or
complicated procedures. And, with products from The Learning
Company, your satisfaction is ensured with a 30-day money-
back guarantee.

The Learning Company's line features the new Super Solvers
series, including the reading and thinking game Treasure
Mountain! (ages 5 - 9), the deductive thinking and reading
comprehension game Midnight Rescue! (ages 7 - 14), the math
problem-solving game OutNumbered! (ages 7 - 14) and the
strategy adventure game Challenge of the Ancient Empires!
(ages 10 & up). The line also includes the award-winning
Reader Rabbit (ages 3 - 7), Math Rabbit (ages 3 - 7), Writer
Rabbit (ages 7 - 10), Think Quick! (ages 7 & up), and The
Children's Writing & Publishing Center (ages 7 - 14).
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